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1. Scope and purpose of this document

Depositing and publishing data at a professional archive offer several advantages: Most funding
agencies require data management plans from applicants for grants which include a description
of the whole research data lifecycle, from data collection to data archiving and sharing.
Moreover, researchers who deposit their data, metadata and documentation material in the
AUSSDA Dataverse increase the chances for receiving visibility, academic credit and increased
citation counts.! In addition, the AUSSDA Dataverse provides data with persistent identifiers (a
DOI) and allows for the preservation and storage of research data in a way that accessibility is
ensured in the future. Thereby, the research community has the possibility to reuse data for
research or teaching and replicate results.

Self-depositing data at AUSSDA is the fastest way for researchers to benefit from all these
advantages of publishing data at a professional and certified repository. This document offers
guidance on the entire deposit process and provides detailed step-by-step instructions on how
data and documentation material need to be prepared in order to be ready for the self-deposit in
the AUSSDA Dataverse. Please note that the self-deposit service is limited to quantitative data
from the Social Sciences with a connection to Austria. Self-depositors can also find supporting
materials at https://aussda.at/. If you are interested in depositing other types of data or from
other disciplines, please contact us, we can refer you to a suitable repository.

If you are familiar with the individual steps of the data deposit process, you can jump directly to
the checklist of the process to make sure that you do not miss any step (Section 6).

2. The individual steps of the deposit process:

an overview

The deposit process starts with the decision to deposit data at AUSSDA and ends with the
publication of the data. The following list provides an overview of the steps and decisions
necessary to take for depositing data at AUSSDA.

e Clarify the legal framework for the published data sets and documentation material
including licenses for each item (see Section 3).

e Prepare the data and documentation material for the deposit. Section 4 provides useful
comments and processes for this step.

e Get to know Dataverse (see Section 5) by creating an entry for publishing your data (see
Section 5.2)

o Section 5.2.1 tells you more about metadata you need to add to your dataset in
Dataverse. This steps also creates a DOI for you.

o Section 5.2.2 guides you through the next steps: file formats, adding the DOI and
version as variables to the dataset, naming your files using the DOI and uploading
everything to Dataverse.

o The third component to every dataset are terms (see Section 5.2.3).

o After checking everything, you can publish your dataset (see Section 5.3).

e If you need to update your dataset, see Section 5.4 on updates and versions.

! https://dataverse.org
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3. Legal questions

Legal questions related to the deposit process concern three aspects:

a. The agreement with AUSSDA that allows depositors to self-deposit data.
b. License agreements for data, metadata and documentation material.
c. The AUSSDA Non-Compliance Policy and potential consequences.

a) The agreement with AUSSDA that allows depositors to self-deposit data

In order to be authorised to self-deposit data at AUSSDA, each depositor is asked to sign an
agreement which specifies the rights and obligations for the use of this service. This standard
agreement is concluded once between the depositor and a legal representative of the University
of Vienna and is the legal basis for all data deposits by this depositor. The agreement template
is available on the AUSSDA website via:
https://aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA_Self-
deposit_Vertrag_SU_1_0.pdf

b) License agreements for data, metadata and documentation material

License agreements determine how users of the AUSSDA Dataverse can use the available data
and documentation. Self-depositors using the AUSSDA Dataverse need to be aware of three
licenses under which their content will be published:

e All metadata in the AUSSDA Dataverse are published under the public domain dedication
(CCO 1.0 Universal), a license that allows for open re-use without attribution.?

e All documentation material accompanying datasets (e.g. questionnaires or codebooks)
are published open access under a Creative Commons Attribution 4.0 International
license (CC BY 4.0). This means that documentation material is openly available and can
be downloaded by all users of the website (after agreeing to the terms and conditions). A
CC BY license allows for reusing and sharing the material under the condition that
attribution is given to the original authors.® We recommend that you include a notice on
the licence in the documentation material (see Section 4.3).

e The “License for use for scientific purposes only” (SUF) is used for all datasets published
by self-depositors.# This licence restricts the use of the material to specific scientific
purposes. In addition, in order to access the data, users need not only agree to the terms
and conditions, but they also have to identify themselves either by creating accounts or
by login via their institutional account. When uploading the datasets in the AUSSDA
Dataverse, you need to set the proper restrictions for each data file to guarantee that
users have to login before they can download data. Section 5.2.2. "Steps in Dataverse:
Upload Files" contains detailed instructions on how to set these restrictions.

2 https://creativecommons.org/publicdomain/zero/1.0/
8 https://creativecommons.org/licenses/by/4.0/
4 https://aussda.at/en/contracts-and-licenses/scientific-use/
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c) AUSSDA Non-Compliance Policy and potential consequences

Users of the AUSSDA Dataverse must agree to specific terms and general guidelines before
using AUSSDA services. The AUSSDA Non-Compliance Policy® serves to inform depositors and
users of social science data provided by the repository about the possible consequences in case
of non-compliance with the agreed upon terms. In case the repository staff detects any forms of
non-compliance or the repository is informed about the non-compliance of any of its users,
AUSSDA may take certain measures and draw consequences according to this policy and at the
discretion of the AUSSDA staff.

Take aways

Get in contact with AUSSDA and sign the agreement that allows you to self-deposit data.

Understand the license agreements for data, metadata and documentation material.

Read and understand the AUSSDA Non-Compliance Policy.

4. Preparing your data and documentation material

Data are of course the centrepiece of the archiving process and hence likely require the lion's
share of the effort preceding publication. Before archiving, we recommend completing the
following steps that are described in more detail below:

1) Check your data for compliance with the General Data Protection Regulation
(GDPR)® and pseudonymise the data (see Section 4.1)

2) Data cleaning: double-check data for any errors, plausibility, clarity of labels and
consistency with the documentation material (see Section 4.2)

Also have a look at our recommendations about documentation material(s), as comprehensive
documentation accompanying the data is crucial for the re-usability of data. The more
documentation material is made available, the better is the users' understanding of the data.

3) Recommended documentation material: What should be included? (see Section 4.3)

4.1. Check compliance with the GDPR and pseudonymise the
data

Since most of the studies archived with AUSSDA contain information about individuals and
therefore comprise private and/or sensitive information, pseudonymisation processes before
the publication are inevitable. Pseudonymisation protect research subjects against
identification, fulfil the requirements of data protection, and meet ethical research standards. By
signing the self-deposit contract and by accepting the AUSSDA terms of service, self-depositors
agree that the data that will be deposited will comply to the highest data protection standards.

5 https://aussda.at/aussda-non-compliance-policy
6 http://data.europa.eu/eli/reg/2016/679/0j
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As hardly any raw data fulfils these criteria, carefully checking all variables and eventually
recoding or deleting some of them is absolutely necessary.

More detailed information on data protection guidelines is available in the Data Deposit
Guideline”: We strongly recommend depositors to carefully read the Data Deposit Guideline before
every publication as any violation of data protection regulations has consequences.

The following list contains several examples for potential violations of data protection and
countermeasures but is by no means an exhaustive list:

e Remove all direct identifiers

Such as social security number, ID number from data collection institute, full name,
email address, phone number, postal code, data of birth, workplace/employer, vehicle
registration number, bank account number, IP address, student ID number,
passport/identity card number etc.

e Thoroughly check or delete answers to open questions

Answers to open questions may contain detailed information of respondents that allow
for their re-identification. Therefore, all open answers have to be either deleted or
carefully checked for any information that may violate the GDPR.

Example
Q: Do you have any experience in working in politics?

A: | have been elected as delegate in the parliament for party XYZ for 12 years in
arow.

This information is so detailed that (even without the combination of the constituency)
the respondent could be identified easily.

e Check all standard demographic variables and recode the data to broader categories if
variables contain less than 20 observations for certain values:
Examples

Age: aggregate to cohorts if less than 20 observations with certain age (e.g. 15-
20 years, 21-25 years, etc.)

Nationality: categorize into groups with min. 20 observations per nationality
(group together to regions if less than 20, e.g. according to UN geoscheme?)

e Although all the pseudonymisation steps mentioned above have to be completed in any
case, we would like to raise awareness that even more extensive measures may be
appropriate if the data you gathered contains information on especially sensitive
population groups (e.g. children, minorities or victims of crimes) or if your population is
small and hence the re-identification risk is high (e.g. a small town or a group of public
interest like MPs).

" https://www.aussda.at/fileadmin/user_upload/p_aussda/Documents/AUSSDA-Data-Deposit-

Guideline.pdf
8 https://unstats.un.org/unsd/methodology/m49/
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4.2. Data cleaning

In the following paragraphs, we outline some of the processes that proved useful for checking
and cleansing data.

a) Making data easier compatible with other formats

Submitted data should comply to requirements defined in AUSSDA's Data Deposit Guideline® to
make it easier for users of other analytical software to use the data.

Technical setting Reason
System missing

should be coded numerical (e.g. | In Stata, system missing can be implemented as “.a" or
using negative values) " b" etc.. After conversion of the dataset to SPSS, these

( 9 system missings are not displayed correctly anymore.
e.g. -9 no answer;

-8 do not know)

Variable labels are truncated after 79 characters in Stata
and remain incomplete. They may be not understandable
(e.g. rephrase questions for the labels).

Variable labels should not be
longer than 79 characters

Table 1 Requirements to increase cross-software usage.

b) Recommended steps for cleaning the data and labels:

e Checking whether values are labelled clearly, correctly and consistently.

e Checking the accuracy of missing values.

e Spellcheck of variable names, labels, value labels and string variables (e.g. by exporting
all labels to Excel and conducting a spell check).

e Checking whether information is attached to the dataset that you would not like to
archive (e.g. notes attached to the dataset or preliminary comments).

e Scanning data for unlabelled values.

Stata users can find useful commands in the accompanying *.do-file
“recommended_datachecks.do" available here:

c) Comparing the data and documentation material.

We recommend to double-check if all labels are assigned correctly and if the labels assigned in
the dataset correspond to the labels in the documentation material and vice versa. Frequent
errors are e.g. a lack of completeness and comprehensibility of labels.

Examples

e The variable f1_4 has the options “don't know" and ,not applicable" in the dataset, but
the codebook does not contain these options.

9 https://aussda.at/aussda-data-deposit-quideline
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e The variable capturing the respondents' age is named "age_respondent” in the dataset,
but “Age" in the codebook. This discrepancy requires either renaming the variable or
adapting the codebook.

d) Double-checking the plausibility of the data.

We recommend checking the data for outliers and plausibility, hence, whether the observations
are plausible.

Example

e If aresponded is 15 or younger, he/she could not have casted a vote in the last general
election.

e If arespondent indicates to be single, the observation for the spouses' occupation
should be either missing or not applicable.

4.3. Recommended documentation material: What should be
included?

Comprehensive documentation accompanying the data is crucial for the re-usability of data. The
more documentation material is made available, the better isthe users’ understanding of the data.
The following list provides an overview which files we consider as mandatory or recommended to
enhance re-use:
I.  The following documents are mandatory for publication:
e Datafiles
e Documentation material; at least one of the following documents have to be included:
o Instrument of data collection (questionnaire with interviewer instructions, information
material for respondents, data collection guidelines)
o Codebook
o Methods report
o Field report

Il.  The following documents enhance the re-usability of the data:
e Project report
e Tabulation report
e Data Management Plan (DMP) of project proposal
e Interviewer guidelines
e Interview cards
e Documentation about incentives, contacts...
e Recoding protocol
e Informed consent form template
e Any further documents that help users to understand the data

We recommend including a suggested citation and information about the license of the
document in each document, preferably on the first page. As outlined above, documentation
material is published under a CC BY license. The information on this license consists of two
aspects: the CC BY logo can be downloaded from the Creative Common's website
(https://creativecommons.org/about/downloads) in several formats. The second aspect is a
text component containing the title of the document, the information of the author(s), the year,
and a link to the Creative Common's website explaining the terms of the license
https://creativecommons.org/licenses/by/4.0/.
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Below, you find an example how this information can look like:

Questionnaire for the EOSC-Pillar "National Initiatives" Survey by Anita
Bodlos, Lisa Honegger, Lars Kaczmirek, Volker Beckmann, Vincent Breton,
Genevieve Romier, Jos van Wezel, Achim Streit, Uros Stevanovic, Fulvio Galeazzi,
Federica Tanlongo, Inge Van Nieuwerburgh (2020) is licensed under a Creative
Commons Attribution 4.0 International Licence.

Take aways

| pseudonymised my data, following the examples and AUSSDA's Data Deposit Guideline.

| cleaned the data as suggested, e.g. regarding variable and value labels and missing values,
among others.

| double-checked the data with regard to plausibility and outliers and they are fine.
| compared the data with the documentation material and they match.
| gathered all documentation material for my data.

I included a suggested citation and information about the license of the document in each
document, preferably on the first page.

5. Self-depositing your data in Dataverse

The following pages contain a detailed step-by-step guide for uploading your data in Dataverse
and finally publishing your work.

Be aware, that after you publish your dataset, this step cannot be reversed. If you discover a
grave error, please contact us immediately. Together, we can devise a plan of action. In the
worst case, this may include deaccessioning your dataset so that users cannot access the
uploaded files anymore. A reason for deaccessioning your dataset would be if a high risk of
identification of data subjects existed. However, the metadata of your study, including the DO,
will always be findable'?, openly available and harvested by other data catalogues.

AUSSDA Dataverse is the digital archive of AUSSDA - The Austrian Social Science Data Archive.
It is based on the open source application Dataverse which has been developed by Harvard
University.

Dataverse is the name of our archival software but it is also a "folder” for researchers, projects
or journals to share and make their data available. As a self-depositor, your data will be stored in
the “Self-Deposit Dataverse". This Self-Deposit Dataverse contains all datasets curated by
accredited self-depositors. A dataset consists of metadata, files (research data,
documentations, code, etc.) and terms.

10 If you want to know more about why metadata are still available, see more in CESSDA's PID Policy
(https://doi.org/10.5281/zen0d0.3611327).
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Some settings in Dataverse are set by AUSSDA and cannot be changed: Metadata fields that are
marked as “required” need to be filled. Also, the settings in the Self-Deposit Dataverse allow all
logged-in users to download account-based scientific use (SUF) files.

Other self-depositors in the Self-Deposit Dataverse see your drafts, and can even edit them, but
they cannot publish them. So please show the courtesy not to edit drafts/entries by other self-
depositors (any changes are recorded in log files).

5.1.Login
mmm) Go to “data.aussda.at”".

mmm) “Sign up” or “Log in".
A US S DA Sl ikcme

Add Daia - Search - About User Guide Support
AUDDOUA
AUSSDA We make social science data accessible, creating opportunities for research and data reuse, benefitting science and
(AUSSDA) society.
JdiMetrics 25,067 Downloads i Contact (® Share

Find data, share data, and cite data with confidence.

The AUSSDA archive is organized into "dataverses”. A dataverse is a collection of datasets around a special topic or source.
Want to establish your own dataverse or publish your data with AUSSDA? Just contact us!

Figure 1 Dataverse Log in and Sign up.

There are two forms of registration. You either register a local account under “Sign up" or use
your institution's login data under “Log in".

If you choose “Sign up” (Figure 1), you can choose a username and password and create a local
account in our Dataverse. The next time you visit our Dataverse, you can use that username and
password to access your account under “Log in".

If you choose “Log in" for institutional login, you will be asked to “connect with your institution’s
login”. You can look for your institution, either by scrolling through the list (you have to look for
the English name of your institution) or by typing the English name in. You are then forwarded to
the login page by your institution, where you log in using your institutional username and
password. If you encounter any problems, please contact us.

If you cannot find your institution in the list, please contact us and choose “Sign up" in the
meantime.

If at first you used the “Sign up” option and then you want to use institutional login with the
same e-mail address, the system will ask you if you want to merge the two accounts. This
cannot be undone. If you merge, we cannot reset your password anymore, as it is your
institutional password.

If this is your first self-deposit: send the AUSSDA-Team a quick message including your
username so they can add you to the Self-Deposit Dataverse.

Havedata?Needdata? wWww.aussda.at
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5.2. Create a dataset entry

As mentioned above, the Self-Deposit Dataverse contains all datasets curated by accredited
self-depositors. A dataset consists of:

1) Metadata (Section 5.2.1)

2) Files (Section 5.2.2)

3) Terms (Section 5.2.3)

Below we will guide you through entering your metadata, data and documentation in the Self-
Deposit Dataverse, starting with Metadata.

5.2.1. Metadata

Metadata describe available data resources of an archive to facilitate searching for and
cataloguing of data. Metadata offer a systematic overview of the data resources and contain
e.g. information on the author(s) or keywords on the data. Open and unrestricted access to
metadata is essential for effective data use and re-use. To this end, metadata in the AUSSDA
Dataverse are always published under the public domain dedication (CCO 1.0 Universal) and
may thus be freely and openly accessed and used by the public.

You prepare the metadata that make the data Findable, Accessible, Interoperable and Re-usable
(FAIR). By following the FAIR principles, you make research data attractive to other researchers.
The description of the deposited data follows international standards set by the Data
Documentation Initiative (DDI)'" and the Consortium of European Social Science Data Archives
(CESSDA ERIC)'2. For several metadata entries, we use established “controlled vocabularies" of
standardised items. This standardisation allows for comparability of the metadata in the entire
AUSSDA data holdings and also for comparability within the international CESSDA data
catalogue. Therefore, using the controlled vocabularies is mandatory for all publications in
Dataverse. Please do not use thousands separators, as they may cause problems when
metadata are harvested by other data catalogues. For example, instead of writing “12,300
participants answered the survey”, do not use the separator and add the text “12300
participants answered the survey".

Please be aware that the working language in our Dataverse is English.

We recommend that you read the entire section on metadata and prepare all metadata
accompanying your dataset (see Table 2) before you actually create a dataset entry and start
entering the metadata in Dataverse.

Steps in Dataverse: Add Metadata
mm) Go to the “Self-Deposit Dataverse”.'®

‘ On the right, middle side of the page, click ,+ Add Data" > “New Dataset" (see Figure 2).

If you cannot see this button, please contact us.

" https://ddialliance.org/
12 https://www.cessda.eu/
13 https://data.aussda.at/dataverse/self-deposit
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Self-Deposit (AUSSDA-accredited self-depositors from different insitutions)

AUSSDA - Self-Deposit

i Contact (2 Share

In this Dataverse, AUSSDA-accredited self-depositors share their datasets directly with users. AUSSDA is not
involved in the self-deposit service

Search this dataverse... Q Fing + Add Data ~

Advanced Search
New Dataset

v & Dataverses (9) This dataverse currently has no dataverses, datasets, or files. You can
7 ['g_" Datasets (0) add to it by using the Add Data button on this page.
E Files (0)

Figure 2 Adding a ,New Dataset" to the “Self-Deposit Dataverse".

After clicking on “New Dataset", a new page appears on which, you can enter all required
metadata fields using the “Self-deposit: Scientific Use" template (see Figure 3).

Self-Deposit (AussDA-accredited self-depositors from different insitutions)

ASSDA = Self-Deposit = New Dataset
Host Dataverse

Changing the host dataverse will clear any fields you may have entered data into

Self-Deposit

Dataset Template

Changing the template will clear any fields you may have entered data into

Self-deposit (SUF terms)

=p None
AUSSDA (OA terms)
AUSSDA (SUF terms)
Microcensus 2020 (SUF)

Self-deposit (SUF terms)

Add "Replication Data for" to Title

Author * Name * Affiliation *
Name, First Name University of... S
Identifier Scheme Identifier
Select...
Contact Name * Affiliation *
Name, First Name University of_.. +

Figure 3 Using the Self-Deposit template, enter all your metadata.
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‘ “Host Dataverse": no changes needed, Self-Deposit is correct.
- Under “Dataset Template”, choose the “Self-deposit: Scientific Use” template.

Here are some tips:

e Some fields are prefilled in the template. In Table 2, you can find more information where
you need to replace information and where no changes are needed.

e Required fields that you need to fill are marked with a red asterisk *.

o If we ask you for information that you do not have or is not applicable to you, fill the field
with “n/a".

e If you are not sure which category of a controlled vocabulary applies, choose the higher
level one.

Metadata table with examples

Table 2 gives an overview over the different metadata fields. The table also presents some
examples and contains a column that serves as a checklist. We provide links to the related
vocabularies in the text and the footnotes.

You can find an example of a dataset in the AUSSDA Dataverse here:
https://data.aussda.at/dataset.xhtml?persistentld=doi:10.11587/QDETRI

Some of the links in the table below are outgoing links to controlled vocabularies that we use to
follow CESSDA ERIC standards. Here are some tips on how to navigate these pages:

ELSST — The European Language Social Science Thesaurus

The European Social Science Thesaurus (https://thesauri.cessda.eu/elsst/en/) is a very
extensive resource. In the upper, right corner you can type in a word you would like to use as a
keyword or you can navigate on the left side by either scrolling alphabetically or in the
hierarchical view.

Important for you:

e Please choose from preferred terms, broader or narrower or related concepts (clickable
terms). Other terms, like entry terms, should not be used to index your dataset.
In the example in Figure 4 the search word was "“political science". As this is an entry
term, the user has been forwarded to the preferred term "Politics".

e When entering the “Term" in Dataverse, do not use all capital letters. See examples in
Table 2.

e If you cannot find a keyword in ELSST, add the term to your abstract text to make it
findable in Dataverse.

Choose a maximum of 14 keywords. If you need more, try to choose a broader concept.

Havedata?Needdata? wWww.aussda.at


https://data.aussda.at/dataset.xhtml?persistentId=doi:10.11587/QDETRI
https://thesauri.cessda.eu/elsst/en/

Consortium of European Social Science Data Archives

cessda
ELSST Thesaurus

ELSST Thesaurus

Alphabetical Hierarchy

-OCCUPIED TERRITORIES
--OFFENCES
~ORGANIZATIONS
"PARTICIPATION
-PERSONALITY

~PESTS

-PHILOSOPHY
PHOTOGRAPHY

FPHYSICAL ACTIVITIES
-PHYSICAL PROPERTIES
~PHYSICS

-PHYSIOLOGICAL EFFECTS
~POLITICAL ACTION
~POLITICAL INSTITUTIONS
-POLITICAL SYSTEMS
-POLITICAL, SOCIAL AND ECONOMIC
| ISSUES

+PpOLITICS

| --ELECTIONS

| -ELECTORAL SYSTEMS

| "INTERNAL POLITICS

| “INTERNATIONAL POLITICS
| -PARTY SYSTEMS

| -POLITICAL ACCOUNTABILITY
| -POLITICAL BEHAVIOUR

LDOLITICAI CANDIDACY

PREFERRED TERM

RELATED CONCEPTS

elanguage English ~

Documentation About Feedback Help

x

political science

®POLITICS &

ELECTIONS

ELECTORAL SYSTEMS
INTERNAL POLITICS
INTERNATIONAL POLITICS
PARTY SYSTEMS
POLITICAL ACCOUNTABILITY
POLITICAL BEHAVIOUR
POLITICAL CANDIDACY
POLITICAL CHANGE
POLITICAL CRISES
POLITICAL FINANCE
POLITICAL GROUPS
POLITICAL INDICATORS
POLITICAL ISSUES
POLITICAL PARTICIPATION
[show all 19 values]

CIVIL AND POLITICAL RIGHTS
GOVERNMENT

Figure 4 Controlled vocabulary for Keywords: ELSST.

CESSDA Topic Classification

The CESSDA Topic Classification (http://aussda.at/cessda-topic-classification) is not as
extensive as ELSST. In the column "Descriptive term” you see broader topics in bold font and

sub-topics in normal font.

Important for you:

e Please choose from the column "Descriptive term".

e In the column “Term notes"” you can see how each term is described.

AUSSDA

AUSTRIAN
SOCIAL SCIENCE
DATA ARCHIVE

e Searching for a topic: Use the search function of your PDF reader to find matching
topics (e.g. by starting the search with Strg./Ctrl.+F) or scroll through the document.
You may need to download the document first in order to be able to use the search

function.
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Choose a maximum of 7 topics. If you need more, choose a broader topic.

opic_Classification pdf - Adobe Acrobat Pro DC
Datei Bearbeiten Anzeige Fenster Hilfe

Start ~ Werkzeuge CESSDA Topic_Class... %

zu verhindern.

Have data? Need ¢

S
classifying a data

g o 0D

r all upper case) should only be used if no narower terms are applicable. More than one term can be used for

@ Ann|

S B EH QA D O® 2i=n A MO @ em - Fmr e

(@) Diese Datei verlangt Konformitst mit dem PDF/A-Standard und wurde schrelbgeschitzt geffnet, um Anderungen

Bearbeitung ak

Descriptive term riptive term: Tem notes
German

Term nates: German

erungsstatistik
Demography
(pop ion, vital

P
tatistics, and
Morbiditat und Mortalitat | Morbidity refers to incidence of ill health in a
uses) population. Data may cover the Incidence or
i rate of a medical condition. For example,
the number of peaple who suffer from lung cancer
na eountry or 8 geograprie area during a single

year.
WMortality data indicate the numbers of deatns in a
pepulation by piace, time, cause, or type of
individual efc. For example, matemal mortality rate,
child mortality rate.
Nate:

Unter Morsidiat wird die Krankheitshaufigheit
innerhalb einer Bevolkerun gsgruppe verstanden
Daten kénnen sich auf das Vorkommen oder die
Morbidtatsrate emer Krankheit bezienen, zum
Beisgis! die Anzahl der an Lungenkrebs leidenden
Personzn in einem Land im Zeitraum eines Jehres.
Daten zur Mortalitat geben die Anzahl der Todestalle
in siner Sevelkerungsgrupps nach Ort, Zeit, Ursache,
Personsngruppe 0., an. Beispiele sind
Mitterstertlichkeit und Sauglingsstertlichieit. Fur

o y inesses
and med cal conditions are indexed vith HEALTH
hierarchy terms.

Krankneitar und
Gesundheitsproblemen bitie die entsprachenden
der Klasse GESUNDHEIT verwenden

Censuses Velkezahiungen SUrveys of an entire population, as opposed 1o &
sample survey. Oflen used for offisial enumerstions
of a population, usually including the collection of
related darmographic information. Note that in some
countiles censuses are not used as demagraphic
information can be obtained from official registers

zu Slichprobenbefiagungen. In der Regel is cer
Zweck eine offsielle Crhebung der

bel

Erhabling weiterer demographischer Informationen

In manchen Landern sind Volkszahlungen nicht

blich, ¢a entsprechende demagraphische

Infrmatonen der offiz ellen Stafisk bzw amfichen
ichin kérnen.

Migration Migration Includss immigration, emigration, internal migraton

Bainhaltet Immigration, Emigration, Binnenmigration
ch Mobilitat

e ey lacan ale.d

Figure 5 Controlled vocabulary for Topics: CESSDA Topic Classification.

DDI — Data Documentation Initiative
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For some metadata fields, we use terms from the DDI controlled vocabularies. Each of these
terms has a website including a table with three columns. The terms that you can copy and
paste to your Dataverse entry can be found in the column in the middle with the name
“Descriptive Term of the Code". In the column on the right, you can see a description of each

term.

DDI Controlled Vocabulary for Kind of Data Format

Description

Deseribes the physical format(s) of the data documented in the logical product(s) of a study uait.

Details

Short Name: KindOfDataFormat
Long Name: Kind of Data Format
Version: 10

Version Notes:

Version Changes:

Canonical URT: urn:ddi-cv:KindOfMataFormat

Canonical URI of this version: urn:ddi-cv:KindOfDataFormat: 1.0

Location URI: “ViKindOfDataFormat_1.0_Ge ode] 00_DDI-CVProfilel 0.xml
Alternate format location URT: CViKindOfDataFormat 10 html

Alternate format location URL: CV/KisdOBata¥ormat L0 LnputSheet Excel2003 xl

Agency Name: DDI Alliance

Code List

Descriptive
Term of the

Value of
Code

Definition of the Code

Numeric A consisting largely of values expressed as digits from 0 to 9 and. optionally. signs for negative values, decimal
dints, or letters only when intended to represent numbers (for example. A-F or a-f in hexadecimal).
Text Data consisting largely of text, including letters, numbers, and special characters or symbols used in writing for
punctuation, abbreviation, elc. For example, interview transcriptions, narratives or essays written by study
‘participants. newspaper articles. lc.
Stilllmage Still image Static images. such as graphs, drawings, photographs, diagnostic/medical images like X-rays, etc.

Figure 6 Example of a DDI controlled vocabulary: Kind of Data.
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Metadata Description Example for Example for Dataverse Tips & Tricks Yeah,
item survey data content analysis | got
data this!
Title #14 Full title by which the dataset is known + “(SUF | Your title (SUF Your title (SUF It is possible to also enter “Alternative
edition)". edition) edition) title” (e.g. German translation), see
Replace "Your title" with the name of your SSSF{?” ?t'\(jlpf '3 I?a}averse. Add
dataset. The second part of the title, "(SUF aaditional Vetadata
edition)" enhances the visibility of the access
mode. o
Below the tile, there is a "Add: ‘Replication data
for' to Title" button, this is for AUSSDA's
replication service. If you want to deposit the
replication data for a journal article, please
contact us.
Author * Dataverse will use the same order of the Random, Jane, Random, Jane, You can add more authors with the "+"
authors in the metadata for creating the University of University of button.
recommended citation. Author's family name, Vienna, ORCID'® Vienna, ORCID'®
given name or the name of the organization 123456) 123456) If you list an organisation in the field
responsible for this dataset as well as the “author name”, this could later lead to
organization with which the person/author is an error after publishing the dataset. ol

affiliated are required fields. Identifiers are
optional, for example, ORCID is a persistent
digital identifier (PID) that distinguishes
researchers from each other and ensures that
research is recognised.

Just contact us if you do not have
natural persons as authors.

14 Asterisks indicate required fields *
'S https://orcid.org/

16 https://orcid.org/



https://orcid.org/
https://orcid.org/

Metadata Description Example for Example for Dataverse Tips & Tricks Yeah,
item survey data content analysis | got
data this!
Contact * The contacts' surname, first name and Random, Jane, Random, Jane, Dataverse will automatically use your
organization or the name of the organization University of University of account-details as contact information.
who should be contacted for questions about Vienna, E-Mail Vienna, E-Mail If you would like to change them, you
the dataset. can manually edit the fields name, o
The button “contact” at the top of the dataset affiliation anf‘j email a}’ddress. User can
. only see the “contact” button, but not
page allows users to reach out to you with : :
) . the underlying contact details.
questions (see Figure 7).
Description * | An abstract describing the purpose, nature, and Please note that HTML elements are
scope of the dataset. The text is required here, NOT allowed here. You can add more ol
the date field is optional. descriptions with the "+" button.
Subject * 'I_'he smen.tlflc d_|SC|pI|ne of the dataset, most Social Sciences Social Sciences Please choose “Social Sciences”. -
likely Social Sciences.
Keywords *17 | Key terms that describe important aspects of Trustin Electoral issues Enter the correct "Term”, do not use all
the dataset as available in the controlled government capital letters, see examples to the left.
vopabulary ELSST (European Language Social Elections You can add more keywords with the
Science Thesaurus). You can use up to 14 "7 button. If vou add more kevwords
keywords from ELSST to describe your dataset. | Politics 1y y ' o]

If you need more keywords, try to choose
broader concepts.

do not forget to copy the Vocabulary
"ELSST - The European Language
Social Science Thesaurus" and URL
https://elsst.cessda.eu/.

7 https://thesauri.cessda.eu/elsst/en/
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Metadata Description Example for Example for Dataverse Tips & Tricks Yeah
item survey data content analysis | got'
data this!
Topic The classification field indicates the broad Public health Media Enter the correct "Term”, do not use all
Classification | important topic(s) and subjects that the data C capital letters, see examples to the left.
s - ensuses
* cover. You can use up to 7 classifiers from the . . o
! o . You can add more topics with the "+
CESSDA topic classification (controlled Education .
button. If you add more topics, do not
vocabulary). If you need more, try to choose p o]
) . S forget to copy the Vocabulary "CESSDA
broader terms. Here is the list of topics: . T
http://aussda.at/cessda-topic-classification Topic CIaSS|f|cat|9n and URL
: : https://vocabularies.cessda.eu/vocabul
ary/TopicClassification
Related The information of related publications The data are The data are "Citation": Enter the full bibliographic
Publication consists of multiple fields (citation, unique related to the related to the paper | citation here.
identifiers and URLs) and is optional. paper "Random, “"Random, Jane. “ID type”: Type of unique id (e.g. doi
Jane. (YYYY). (YYYY). Why ype: 1yp g -g- dol,
. ISBN)
Impact of X on content analysis is
Electoral great. doi: “ID number": number of the unique
Behavior”. doi: 10.01234/ABCAE. identifier o
10.01 ?34/ABC4E. (https://doi.org/10. URL: Link torthe paper(preferablylusing
(https://doi.org/1 | 01234/ABCA4E). he link of th ) dentif
0.01234/ABCAE) the link of the unique identifier (e.g.
’ https://doi.org/10.01234/ABCA4E)
You can add more publications with the
"+" button.
Notes Please do not change the prefilled information. | This dataset has This dataset has
been curated and | been curated and
deposited by one | deposited by one of jol
of our accredited | our accredited self-
self-depositors. depositors.
Language * Language(s) of the dataset German, English German You can choose multiple languages. -

8 http://aussda.at/cessda-topic-classification



http://aussda.at/cessda-topic-classification
https://vocabularies.cessda.eu/vocabulary/TopicClassification
https://vocabularies.cessda.eu/vocabulary/TopicClassification
http://aussda.at/cessda-topic-classification

Metadata Description Example for Example for Dataverse Tips & Tricks Yeah
item survey data content analysis | got'
data this!
Grant The agency that provided funding and the grant | Federal Ministry H2020: FA123456 You need the Grant Agency and the
information: number of the project. of Science, Grant Number. If this field does not
Grant agency Research and apply to you, please enter “n/a". You o
* and grant Economy: HRSM - can add more grant information with
number * XYZ4 the "+" button.
Distributor * Please do not change the prefilled information. | The Austrian The Austrian Social
Social Science Science Data ol
Data Archive Archive
Depositor * The person(s) (family name, given name) or the | Surname, first University of X: There is only one field, if you have more
name of the organisation(s) who own(s) the name Department of than one depositor, you can separate
data. Communication them with a semicolon (*;") between the o}
names.
Deposit Date | Prefilled with date of draft curation. Keep or
delete as Dataverse generates an additional o)
publication date.
Date of Date when the data collection started in the 2019-10-22 2019-10-22 If you have several waves for a dataset,
collection: format (YYYY-MM-DD). we recommend that you add the very
Start * first start date and the last end date of
your data collection period. You can o)
add more information about the
different dates later as additional
metadata information.
Date of Date when the data collection ended in the 2020-03-30 2020-03-30 See above.
collection: format (YYYY-MM-DD). ol

End *




Metadata Description Example for Example for Dataverse Tips & Tricks Yeah
item survey data content analysis | got'
data this!
Kind of Data Choose from list: Numeric, Text, Still image, Numeric Text; Other You can add more fields with the "+"
*19 Geospatial, Audio, Video, Software, Interactive button.
resource, 3D, Other. For all DDI fields: Choose a category
See descriptions here: Controlled vocabulary that is predominant, for example, if you
Kind of Data (DDI) have one string variable and five o]
numerical variables — choose
“Numeric” or if the string is very
important choose both “Numeric" and
"Text".
Data Sources | A typology of data source that has been used Population group | Communication: You can add more fields with the "+"
%20 to generate the data. The total list can be found Public button.
here: Controlled vocabulary Data Sources
(DDI). Please note that “Research data" should
only be chosen if your data relies on pre-
existing research data (e.g. you merge or
combine research data). ,Population group” is o}
most likely the right choice if you survey
individuals.
Examples: Population group, Communication:
Public, Research data,
Registers/records/accounts, Other, ...
Geographic Information on the geographic coverage of the | Austria Vienna, Austria You can add more countries with the
Coverage * data. You have to enter information in the field "+" button. -

“Country/Nation". The fields "State/Province”,
“City" and "Other" are optional.

19 https://ddialliance.org/Specification/DDI-CV/KindOfDataFormat_1.0.html

20 http://www.ddialliance.org/Specification/DDI-CV/DataSourceType_1.0.html
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Metadata

Description

Example for

Example for

Dataverse Tips & Tricks

item survey data content analysis TZ?::’
data this!
Unit of Basic unit of analysis or observation that this Individual Text Unit You can add more fields with the "+"
Analysis *?' dataset describes. button.
Choose from list: Individual, Organization,
Family, Family: Household family, Household,
Housing Unit; Event/Process, Geographic Unit, a
Time Unit, Text Unit, Group, Object, Other
See descriptions here: Controlled vocabulary
Unit of Analysis (DDI)
Universe * Description of the population covered by the Austrian resident | Any news articles You can add more fields with the "+" -

data in the file; the group of people or other
elements that are the object of the study and to
which the study results refer. Age, nationality,
and residence commonly help to delineate a
given universe, but any number of other factors
may be used, such as age limits, sex, marital
status, race, ethnic group, nationality, income,
veteran status, criminal convictions, and more.
The universe may consist of elements other
than persons, such as housing units, court
cases, deaths, countries, and so on. This term
is also known as the universe of interest,
population of interest, and target population.

population from
age 14

in the respective
media outlets.

button.

21 http://www.ddialliance.org/Specification/DDI-CV/AnalysisUnit_1.0.html
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Metadata

Description

Example for

Example for

Dataverse Tips & Tricks

item survey data content analysis T‘Z:::’
data this!
Time Method | The time method or time dimension of the data | Longitudinal: Other Single entry field but you can add more
%22 collection, the total list can be found here: Panel time methods by separating your
Controlled vocabulary Time Method (DDI) entries with a semicolon (,;").
Examples: Longitudinal, Longitudinal: -
Trend/Repeated cross-section, Longitudinal:
Panel, Time series, Cross-section, Other
Sampling Type of sample and sample design used to Non-probability: Probability: Single entry field but you can add more
Procedure *23 | select the survey respondents to represent the | Quota Stratified sampling procedures by separating
population, the total list can be found here: your entries with a semicolon (,;").
Controlled vocabulary Sampling Procedure
(DDI)
o}
Examples: Total universe/Complete
enumeration, Probability, Probability: Stratified,
Non-probability, Non-probability: Quota, Mixed
probability and non-probability, Other
Collection Method used to collect the data, the total list Self-administered | Content coding Single entry field but you can add more
Mode *24 can be found here: Controlled vocabulary questionnaire: methods of data collection by
Collection Mode (DDI) Web-based separating your entries with a
Examples: Telephone interview: CATI, Self- semicolon (;"). o]

administered questionnaire: Web-based, Focus
group, Content coding, Transcription,
Compilation/Synthesis, Other

22 http://www.ddialliance.org/Specification/DDI-CV/TimeMethod_1.2.html

23 http://www.ddialliance.org/Specification/DDI-CV/SamplingProcedure_1.1.html

24 http://www.ddialliance.org/Specification/DDI-CV/ModeOfCollection_3.0.html
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Metadata

Description

Example for

Example for

Dataverse Tips & Tricks

guestionnaire, Interview scheme and/or
themes, Data collection guidelines,
Programming script, Other

item survey data content analysis Ti:::’
data this!
Type of Type of data collection instrument used, the Structured Data collection Single entry field but you can add more
Research total list can be found here: Controlled questionnaire guidelines used time methods by separating your
Instrument *25 | vocabulary Type of Research Instrument (DDI) entries with a semicolon (,;").
Examples: Questionnaire, Structured o}

Table 2 Metadata fields, examples and links.

Do not yet upload your data and documentation files as they still need some changes outlined below in Section 2)5.2.2.
mmm) Click ,Save" as a next step.

You can revise and edit your metadata also at a later point in time.

25 https://www.ddialliance.org/Specification/DDI-CV/TypeOfinstrument_1.1.html
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Steps in Dataverse: First Draft saved

Root = Dataverse name Your dataset | SUF edition)
o Success! — The selected files have been deleted. \
M Contact I Share @ Publish | # Edit-
P { Files (Upload \
> Your dataset (SUF edition) (Upload)
Metadata
m Terms
Familyname, Firstname, 2020, "your dataset (SUF edition)”, https /fdei.orgM0.11587/ABC123 1] Permissions
Q Private URL
= Cite Dataset - Learn shout Data Citation Standards. 0 Do Thumbnails + Widgets
\ Delete Dataset J
Abstract This dataset is curated by XK as a self-deposit. Add Abstract directly here.
Subject Social Sciences
Keyword Elections
Files Metadata Terms ‘fersions
=+ Upload Files
There are no files in this dataset.

Figure 7 Edit your dataset in Dataverse.

Here (Figure 7), you can see, how your dataset draft looks like after saving the required
metadata. The “Edit" button in the right corner is very important. There, you can

1) Upload and restrict files: “Files (Upload)" (see Section 5.2.2).

2) Add additional information: “Metadata” (see next topic below).

3) See the Terms of Use and Terms of Access: “Terms" (see Section 5.2.3).

4) Delete your dataset draft (learn more about this and Publishing in Section 5.3).

Steps in Dataverse: Add additional Metadata
‘ You can add additional metadata by clicking on “Edit" > “Metadata”.

There you can see additional fields, that are not mandatory for a deposit.

We recommend also checking for and eventually correcting trailing blanks (a space after the last
digit) and spelling errors.

Some fields you could add:

e Alternative title: If you want to increase the search hits for your dataset, use this field to
enter the German name of your dataset here.

e Contributor(s): You can select different types of contributor(s) to the data set. It is
possible to mention data curator(s), data collector(s), researcher(s) here. You can add
more contributors with the "+" button.

e And many more optional fields...

mmm) Either “Save changes” or “Cancel”.

Havedata?Needdata? www.aussda.at
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Take aways

| gathered all relevant metadata and filled my dataset draft in Dataverse with the relevant,
correct information.

5.2.2. Files in Dataverse: Add your documentation and data

In this section, we outline in detail the necessary steps for preparing the data and
documentation material to upload them in Dataverse.?6 This includes:

e File formats

e Saving DOI and version as variables in the dataset
e File naming

e Uploading files in Dataverse

File formats

AUSSDA encourages the self-depositors to use the recommended file formats to enhance re-
use of data. Using the recommended formats also ensures that your files are secured long-time
as they are fully compatible with our long-time archival and preservation strategy.

During the upload, Dataverse automatically generates a tab-delimited version of many data
files, also of Stata and SPSS-files. This process is called “ingest”" and takes some time. You will
receive an e-mail after the ingest is complete. When clicking the “Download” button, the original
file format is still the first download option for users, open formats are provided for usage in
other software. By conversion to *.tab-format, long-term re-use is secured. For more details on
this topic and how Dataverse treats other formats, please see the Dataverse user guide?’.

Documentation

We recommend saving the documentation material as PDF/A, a secure long-term format. You
can find step-by-step instructions here?® (German), here?® (English) or here®® (English). These
are different solutions since the conversion steps depend on the software you use.

Data

The most frequently used formats in the AUSSDA Dataverse are SPSS (*.sav) and Stata (*.dta).
We recommend using the unicode format for all files and to avoid diacritics if possible.

For Stata users

We recommend saving Stata files in version 14 as unicode is the default file format since
Stata 14 and users may not always have the most recent version of Stata at their
disposal.

26 See also the Data Deposit Guideline.

27 http://quides.dataverse.org/en/latest/user/tabulardataingest/index.html

28 https://zid.univie.ac.at/computer-rooms/anleitungen/pdfa-erstellen/

29 https://library.princeton.edu/special-collections/sites/default/files/Creating_PDFA.pdf
30 https://blogs.adobe.com/acrolaw/2011/05/using-save-as-to-to-conform-to-pdfa/

Havedata?Needdata? www.aussda.at
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For SPSS users

We recommend running SPSS in unicode mode (default mode since SPSS version 21),
data files will then be stored in unicode encryption.?'

For Excel users

Do not use Excel as a data format, we recommend saving datasets as *.csv (UTF-8
encoded):

For EXCEL 2016:
Go to "File" -> “Save As" -> select “CSV UTF-8 (comma delimited) (*. csv)"

If it is really necessary to publish Excel files, please double zip the file before uploading.
Dataverse can ingest Excel files, but e.g. the usage of more than one Excel-sheet will
produce ingest errors.

For the best reuse of your data, we recommend storing your data also in other file formats that
are used by the community. If you want to learn more, do not hesitate to contact us.

Save the DOl and the version as variables in the dataset

The DOl is part of the file naming (see section below). In addition, the DOI of the dataset and the
version should also be stored as variables in the dataset. Thereby, users can see which version
they use in their analyses at a glance and can cite the data easily.

Self-Deposit (AUSSDA- dited

salf-depositors from different insitutions)
AUSSDA - Seff-Deposit ~ Your title (SUF edition)

) Success! - The metadata for this datasst has been updated

= Contact & Share @ Publish | # Edit~

Files (Upload)
Metadata

Your title (SUF edition)
B

Heider, Veronika, 2020, *Your title (SUF edition] PRAFT VERSION @ Dataset Me Parmissions
o Private URL
Data Citation Standards. ownioac
L o Thumbnails + Widgets

= Cite Datasst -

Description Here is an abstract o Delete Dataset

Subject Social Sciences
Keyword ¢ Elections, Politics

Notes This dataset has been curated and deposited by one of our accredited self-depositors.

Files  Meladata  Terms Versions

+ Upload Files

There are na files in this dataset

Figure 8 You can find the DOI of your Dataverse entry in the blue citation field and in the tab
“Metadata”. Please note the last 6 digits as suffix of the DOI.

Variable version
The recommended format of the variable "version” is:

e variable name: version

e content: “vmajor.minor (YYYY-MM-DD)", example "v1.0 (2020-08-26)"
e variable label: "AUSSDA archive version”

SThttps://www.ibm.com/support/knowledgecenter/en/SSLVMB_26.0.0/statistics_mainhelp_ddita/sp
ss/base/faq_unicode.html
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Variable doi
The recommended format of the variable “doi" is:

e variable name: doi
e content: “doi:10.11587/ABC123"
e variable label: "digital object identifier"

As the DOl is generated after creating and saving the Dataverse entry, these steps can only be
undertaken shortly before the upload of the dataset. We recommend ordering the version and
the DOI as the first variables of the dataset. The accompanying do-file contains exemplary
commands for these steps.

File Naming

AUSSDA encourages self-depositors to use the recommended file naming scheme which
enables users to quickly understand the content of the files and also makes the file names
consistent over different data deposits. Also, Dataverse does not accept files with identical
names which makes the usage of our recommended file naming scheme even more important.

We recommend naming the files using the following pattern:

DOIsuffix_description_language_version.fileExtension (e.g. ABC123_mr_en_v1_0.pdf)

DOlsuffix

A DOI consists of the prefix (in the case of AUSSDA, the prefix is 10.11587), followed by a
slash (/") and a 6-digit suffix. Hence, the suffix is the combination of letters and
numbers in the DOI after the “/" (e.g. in the DOI 10.11587/ABC123, "ABC123" is the
suffix). As these 6 digits of the suffix are unique to your dataset, use them to name all
your files. You can find the DOI that has been reserved for you in several places in
Dataverse (example: as part of the citation box at the top in Figure 7).

description

AUSSDA usually uses two letters for describing the content of a file. The conventionally
used abbreviations of the content of files are shown in Table 3.

If you upload more than one file per category (e.g. two codebooks), we recommend adding
numbers after the abbreviation (e.g. ABC123_co01_en_v1_0.pdf).

language

AUSSDA conventionally uses two letters for abbreviating the language in filenames for
documentation material or datasets. The most frequently used abbreviations are “de" for
German and “en” for English. Follow the ISO 693-1 code®? if you need abbreviations for
other languages.

32 https://de.wikipedia.org/wiki/Liste_der_ISO-639-1-Codes
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version

The version is usually preceded by the letter “v". We recommend using major and minor

versions that are separated by underscores (“_") rather than a full stop (“."). E.g.
“version 1.1" is given in the style “v1_1".

We recommend avoiding any blanks, diacritics or uppercase letters in filenames.

Abbreviation  Description English Description German

da data Daten

qu Questionnaire Fragebogen

im Interviewer manual Interviewerhandbuch

fr Field report Feldbericht

co Codebook Codierliste

rr Research report Forschungsbericht

mr Method report Methodenbericht

SX Code/ syntax Code/ Syntax

ta Tabulation report Tabellenband

om Other material, specify in anderes Material
Dataverse description

Vi Variable identifiers and Variablenidentifikation und -
descriptions beschreibung

Table 3 Descriptions and abbreviations used for the file names of documentation material

Documentation

Example 1 After creating the Dataverse entry, the DOI "10.11587/ABC123" is created. The
recommended file name for version 1.0 of the questionnaire in English is
ABC123_qu_en_v1_0.pdf.

Example 2 After creating and saving the Dataverse entry, the DOI “10.11587/DEF456" is
created. You have two German and two English method reports. The recommended file
names for the English version 1.0 of your method report are DEF456_mr01_en_v1_0.pdf
and DEF456_mr02_en_v1_0.pdf. The recommended file names for the German method
reports are DEF456_mr01_de_v1_0.pdf and DEF456_mr02_de_v1_0.pdf.

Data

Data files are conventionally abbreviated as “da". For an explanation of all other elements,
please see the section on file naming of the documentation material.

DOlsuffix_da_language_version.fileExtension (e.g. DEF456_da_en_v1_0.dta).

Example 1 Imagine, you have one German and one English Stata dataset that are
identical besides the language. After creating and saving the Dataverse entry, the DOI
“10.11587/GHI789" is created. The recommended file name for the English version 1.0 of
your data is GHI789_da_en_v1_0.dta and for the German data GHI789_da_de_v1_0.dta.

Example 2 After creating and saving the Dataverse entry, the DOI “10.11587/JKL123" is
created. You have two English SPSS datasets. The recommended file names for the
English version 1.0 of your datasets are JKL123_da01_en_v1_0.sav and
JKL1236_da02_en_v1_0.sav.
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Take aways

| saved my documentation material as PDF/A to ensure long-time archive format.
| added two variables to my dataset (“version”" and “doi").
I named my data files according to AUSSDA's suggested file naming scheme.

| generated other file formats to increase the reuse potential.

Steps in Dataverse: Upload Files
Next, you can upload your files to your dataset draft.

mmm) As shown in Figure 7, click on “Edit" > “Files (Upload)".

Figure 9 and the list below contain all the individual steps:

Root = Your Dataverse Your dataset (SUF edition) - Upload Files

° Success! — Files "4182C3 da_en_v1_0.dta" wil be restricted once you click on the Save Changes button.

Files.
Upload with HTTP via your browser A

Select files or drag and drop inte the upload widget.

. + Select Files to Add

Drag and drop files here.

1 File

4
.

File Name  A182C3_da_en_vi_0.dta Delste

Restrict
File Path data .
2 Unrestrict
e, application/x-stata-14 | # Edit~ |
MDS: 882006553 12f2c3a523cdbedSesbe:

Description | core gata file - STATA format - 28
“fariables, 108357 Observations

G Save Changes Cancel

Figure 9 Add files, file metadata and restrictions in Dataverse. Note that the edit button here (marked
with a “4"), is not the same edit button as in Figure 10.

1)  Select all files you want to make available to users. In the next step, add more
information about your files (also called “file metadata").
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2) The file metadata consist of the correct "File Name", a "File Path”, a short "Description”
of the content of the file and “Tags".3?
I.  File name”: You can find information about file naming in the section above.
II.  File Path: Use either "data"” or “documentation”, depending on the file.
[ll.  Description™ Use a short descriptive text to describe the content of your file
Examples: Codebook
Method report
Core data file — STATA format — XX variables, XXX observations
IV.  Tags: See Figure 10 for more details on how to further describe your files.
a) Click “Edit".
b) Choose from the three existing tags (“Data", “Documentation”, “Code").
¢) Add custom tags (choose from tags that relate to Table 3 “STATA", “SPSS",
“Questionnaire”, "Codebook”, “Method report”, "Research report”, "Results”,
“Field report").
d) “Apply custom tags".
e) "“Save changes".

Figure 9 shows the most important steps:

3)  Click the checkbox on all files that will be provided under the scientific use licence (i.e.
the data files).
4)  Goto "Edit".
5)  Click on “Restrict” to restrict your data files.
I.  Add "Terms of Access": Copy and paste to Terms of Access:

<p><b>Ich akzeptiere die fiir die Datei giiltigen Lizenzbedingungen
(Lizenzvertrag). Falls ich alle Dateien auf einmal herunterlade, akzeptiere ich alle
Lizenzbedingungen.</b></p><p>Die Lizenzbedingungen befinden sich oben im
Abschnitt "Terms of Use".</p><hr />For each file you download, you
declare:<p><b>I accept the license terms valid for the file (license agreement). If |
download all files at once, | accept all license terms.</b></p><p>The license
terms can be found above in the section "Terms of Use".</p>

II.  Tick "Enable Access Request".
lll.  Save Changes.

If you see a green, open lock next to the file thumbnail, the restriction is in place. If you
see no lock, try again. If you see no lock after a second attempt, please contact us. The
green lock signifies that the data file is restricted for users that are not logged in (they
see ared, closed lock) and available for logged in users (they also see a green, open
lock).

6) Save the changes.

33 Consider ,File Name" and ,Description” required fields, whereas “File Path” and “Tags" are
optional.
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Select files or drag and drop into the upload widget
* -
Edit Tags
Select existing file tags or create new tags to describe your files. Each file can have more
than one tag.
Selected Tags E3
1 File
File Tags Select... -
Custom File Tag add it as a tag option for al in
Documentation
» Data
Code
Save Changes Cancel | »¢ Stata
%
Description ' core data file - STATA
format - 28 Variables,
108357 Observations

t

'rt-a

Figure 10 Add tags to a file to further describe your file. Note that the edit button here (marked with

an “a") is not the same edit button as in Figure 9.

If something is not working while uploading your files, try the following (see Figure 11):

a) Save any changes.
b) Go to the tab "Files".

c) Mark the checkbox of the file you want to edit.

d) “Edit".
e) Make your changes.
f) Save changes.

Files Metadata Terms Versions
ange View Table Tree
Search this dataset Q Find
Filter by

File Type: All~  Access: All»  File Tag: All =

110 2 of 2 Files

N, 4PFYI2_da de vi1_0Otab
data/
@ Tabular Data - 26.9 KB - Nov 19, 2020 - 0 Downloads

3Variables, 1000 Observations - UNF:6:mCF8KRIpyh7w/40BSI6

ag==
H Core data file — STATA format — 3 variables, 1000 obsemvations

4PFY12_mr_en_v1_0 pdf

documentation/

Adobe PDF - 68.9 KB - Nov 19, 2020 - 0 Downloads
MD5: 3ee9ecd7743151dde 1c6c8a1645d 1ccl
method report

u # Edit Files ~

Delete
Metadata
Restrict
Unrestrict
Tags

+ Upload Files

1t sort~

& Download ~

& Download ~

& Download

Figure 11 In the tab “Files" you can edit metadata, restrict or delete files and add tags.

After you saved your files, Dataverse “ingests" your files. Dataverse will automatically try to
convert your data files to *.tab format. Ingesting can take a while, small files in minutes, larger
files in eight hours or more. While Dataverse processes your data files, you cannot edit the

dataset entry.
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After the ingest is finished, check the numbers of variables and observations, these should
correspond to the original numbers. If there is a difference, contact us. You can also add

additional information to your metadata or files after the ingest is done.

Take aways

| uploaded my files with the correct file naming and a short description text.

All my data files are restricted (I see a green, open lock next to my data file(s)).

| used the "Self-deposit: Scientific Use" template to create my dataset and replaced the pre-filled
fields with my information if necessary.

5.2.3. Terms

As next step have a look at the Terms and check if everything has been added from the “Self-
Deposit (SUF)" template you used.

The “Terms of Use" may not be changed as they are part of the agreement you signed with
AUSSDA and look like displayed in Figure 12.

Files. Metadata

Terms of Use A

Waiver

Terms of Use

Terms

Versions

#8 Edit Terms Requirements

Our Community Norms as well as good scientific practices expect that proper credit is given via
citation. Please use the data citation above, generated by the Dataverse

No waiver has been selected for this dataset.

ENGLISH VERSION FOLLOWS BELOW

Diese Studie besteht aus verschiedenen Dateien, die unter verschiedenen Bedingungen fir die
Nutzung zur Verfigung stehen

« FUr Daten gilt der Lizenzvertrag, um ausschlielich zu einem konkreten
wissenschaftlichen Zweck zu nutzen.

« Fir die Nutzung von Dokumentationsdateien und anderen Dateien gelten gesonderte
Lizenzbedingungen. die weiter unten ausgewiesen sind

Fur die Nutzung von Daten: Li g, um i zu einem
konkreten wissenschaftlichen Zweck zu nutzen

Durch Nutzung der auf der Plattform zur Verfugung gestellten Archivalien und Metadaten akzeptieren
Sie die nachstenenden Lizenzbedingungen und sichern zu, die Archivalien nach der
Zurverfugungstellung ausschiieRlich zu den in der Lizenz geregelten Bestimmungen zu nutzen.
Metadaten sind mit einer CCO 1.0 Universal Lizenz versehen. Deren Nutzung ist uneingeschrankt
moglich

Figure 12 Terms of Use.

The “Terms of Access” should look like displayed in Figure 13, "Request access" should be
enabled, stating “Users may request access to files.”
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Restricted Files

Terms of Access

Request Access

There is 1 restricted file in this dataset.

Ich akzeptiere die fiir die Datei giiltigen Lizenzbedingungen {Lizenzvertrag). Falls ich alle
Dateien auf einmal herunterlade, akzeptiere ich alle Lizenzbedingungen.

Die Lizenzbedingungen befinden sich oben im Abschnitt "Terms of Use".

For each file you download, you declare:
1 accept the license terms valid for the file (license agreement). If | download all files at
once, | accept all license terms.

The license terms can be found above in the section "Terms of Use".

Users may request access o files.

Figure 13 Terms of Access with enabled access request.
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If this field is empty, copy and paste this text to the Terms of Access and enable Access
Request, see Figure 14:

mmm) “Edit Terms Re

qguirements".

‘ Copy and paste to Terms of Access:

<p><b>Ich akzeptiere die fiir die Datei giiltigen Lizenzbedingungen

(Lizenzvertrag). Falls ich alle Dateien auf einmal herunterlade, akzeptiere ich alle
Lizenzbedingungen.</b></p><p>Die Lizenzbedingungen befinden sich oben im
Abschnitt "Terms of Use".</p><hr />For each file you download, you
declare:<p><b>| accept the license terms valid for the file (license agreement). If |
download all files at once, | accept all license terms.</b></p><p>The license

terms can be found above in the section "Terms of Use".</p>

‘ Tick "Enable Access Request”.

mmm) Save Changes.

Restricted Files + Terms of Access

Terms of Access

Request Access

<p=<b=lch akzeptiere die fir die Datei glitigen Lizenzbedingungen (Lizenzvertrag). Falls ich alle
Dateien auf einmal herunterlade, akzeptiere ich alle Lizenzbedingungen </b></p><p=Die
Lizenzbedingungen befinden sich oben im Abschnitt "Terms of Use".</p=<hr />For each file you
download, you declare: <p=<b=| accept the license terms valid for the file (license agreement). If |
download all files at once, | accept all license terms. <fb><fp>|<p>Tne license terms can be found
above in the section "Terms of Use".</p=

+ Enable access request

Figure 14 Adding Terms of Access and enabling access request.

Take aways

| checked that the Terms of Access are filled with the correct text, provided above.
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5.3. Publishing

In this section you learn more about publishing your draft entry. Also, we explain how you can
delete a draft if you do not need it anymore.

Check your dataset

Thoroughly check your dataset in Dataverse before the publication.
Your draft is now finished, congratulations!

If this is your first upload, contact the AUSSDA Team for feedback on the metadata and your
Dataverse entry in general. After the feedback, you can publish the dataset yourself. If this is not
your first data deposit, you can publish right away.

You can go ahead and publish your entry!
mmm) Click “Publish”.
mmm) Confirm by clicking “Continue”.

If you do not get a "Success" message at the top of the page, please contact us with further
details and a screenshot of the error message.

Publishing a dataset may take some time as Dataverse processes your data files, so please be
patient.

Delete drafts
It is possible to delete your draft, if you really do not need it anymore, but it cannot be restored
once deleted (see Figure 15).

mmm) Click “Edit".
mmm) Click “Delete Dataset".
mmm) Confirm by clicking “Continue”.

MiContact 2 share @ Publish | # Edit~

Files (Upload)

Metadata

Terms.
edition)", httips://doi.org/10.11587/4PFYI2, Dpat Permissions
SI60g== [fleUNF] @ Private URL

ocC
Thumbnails + Widgets

Learn about Data Citation Standards

Delete Dataset

Figure 15 Deleting a dataset draft.

5.4. Updates

If you discover that you forgot to add something or want to upload additional files, you can
update your existing dataset.

As soon as you edit something in an already published dataset, Dataverse creates a new “draft"
version of your dataset (see Figure 16). Previous versions including all documents, data and
files always remain unchanged and accessible for users (see tab “Versions" in Figure 17).
Deaccessioning published files should only be done by AUSSDA and is foreseen for legal
reasons (e.g. violations of data protection or intellectual property rights) and requires an
explanation and a justification. Therefore, please check your files carefully before publishing.
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€ Filter Results

1 to 7 of 7 Results 11 Sort~

P

Familyname, Firstname, 2020, "My first publish (SUF edition)",
https://doi.org/10.5072/FK2/GW6RG6, Root, DRAFT VERSION

My first publish (SUF edition)
Oct 7, 2020

B

Add Abstract here.

My first publish (SUF edition)
g Oct 7, 2020

Familyname, Firstname, 2020, "My first pubUF edition)",

i https://doi.org/10.5072/FK2/GWBRGB6, Root\
Add Abstract here.

Figure 16 Draft vs. Published versions in Dataverse.

When all changes are completed and you want to publish your new version, you may have to
make a decision whether it is a major or minor update, see Section "Minor vs. major changes”
below. For a new version, you should also change the versioning in the names of your files, see

Section “File Naming" for more on file naming.

My first publish (SUF edition)
Familyname, Firstname, 2020, "My first publish (SUF edition)", htips://doi.org/10.5072/FK2/GWERGE, Rum
i Cite Dataset ~ Leam about Data Citation Standards.
Abstract & Add Abstract here.
Subject & Social Sciences
Keyword Leisure time
Notes This dataset is curated by XXX as a self-deposit
Files Metadata Terms H
Dataset / Summary Contributors
Ei Files (Changed File Metadata: 1) View Details Second User
1.0 This is the first published version. Second User

0 Downloads

Published
Oct 7, 2020
Oct 7, 2020

Figure 17 Versioning of dataset in Dataverse.

Minor vs. major changes

If there are major changes to data files (filed deleted, new files uploaded, etc.) Dataverse decides

for you: it will be a major update to the next full number.

If you made minor changes, for example in the metadata, Dataverse asks you if this is a major
update (changing to the next full number) or a minor update (changing the decimal place, e.g.
1.1, 1.4, etc.). The changes made to your data entry can be followed under the tag “Versions"
(see Figure 17), click “View Details". You can also find more information in the AUSSDA User

Guide on major/minor3*.

84 https://aussda.at/userguide/#c291053
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6. Checklist Box for whole deposit process
Legal questions Yeah, | got this!
Get in contact with AUSSDA and sign the agreement that allows you to .
self-deposit data.
Understand the license agreements for data, metadata and documentation material. N
Read and understand the AUSSDA Non-Compliance Policy. .
Preparation of data & documentation material
| pseudonymised my data, following AUSSDA's Data Deposit Guideline. N
| cleaned the data as suggested, e.g. regarding variable and value labels and missing a
values, among others.
| double-checked the data with regard to plausibility and outliers and they are fine. a
| compared the data with the documentation material and they match. o]
| gathered all documentation material for my data. o]
I included a suggested citation and information about the license of the document in a
each document, preferably on the first page.
Metadata
| gathered all relevant metadata and filled my dataset draft in Dataverse with the
relevant, correct information. Q
Files
| saved my documentation material as PDF/A to ensure long-time archive format. o]
| added two variables to my dataset (“version” and “doi"). a
I named my documentation files according to AUSSDA's suggested file naming o}
scheme.
| generated other file formats to increase the reuse potential. o]
I used the “Self-deposit: Scientific Use" template to create my dataset and replaced all o]
pre-filled fields with my information.
| uploaded my files with the correct file naming and a short description text. o]
All my data files are restricted (I see a green, open lock next to my data file(s)). o]
Terms
I checked that the Terms of Access are filled with the correct text, provided above. 0]
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